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Role of Quality Engineering
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Analysis of process capability

Process capability index (Potential capability)
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Example 11

In a manufacturing process the expected value of a quality 

characteristic is = 250.727 unit, the standard deviation is 

= 1.286 unit. The specification is 2505 unit.

How much is the proportion of defectives in this process?

Calculate the CP capability index!
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Corrected indices (demonstrated capability)
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Modified process capability index

capability index modified capability index
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related to Taguchi’s  quadratic loss function
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Example 12

In a manufacturing process the expected value of a quality 

characteristic is  = 250.727 unit, the standard deviation is 

 = 1.049 unit. The specification is 2505 unit.

Calculate the corrected and modified capability indices!
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= 250.727 

= 1.049 

specs: 2505



97Six Process Capability

Example 3

Calculate the capability indices and the proportion beyond 

specs (above USL or below LSL) for YS2 data in the dataset 

cpdata1.mtw!

The specification is 2505 unit.

Open cpdata1.sta Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Variables: YS2

Process specs…
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= 248.655

= 0.98875

specs: 2505

Summary histogram
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Variable: YS2        Mean: 248.655

Sigma (Total):0.98875 Sigma (Within):0.00000

Specifications: LSL=245.000 Nominal=250.000 USL=255.000

Normal: Cp=1.686 Cpk=1.232 Cpl=1.232 Cpu=2.139
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Advanced, normal

Descriptive statistics Number beyond specs

Descriptive Statistics (CPDATA1.STA)

Variable:YS2

N = 100

Statistic Value

Mean

Median

25th Percentile (Q25)

75th Percentile (Q75)

Minimum Value

Maximum Value

Standard Deviation

Variance

Skewness

Kurtosis

248.65520000

248.70500000

248.03000000

249.31000000

246.26000000

251.06000000

0.98874727

0.97762117

-0.13596413

-0.01110165
Variable: YS2, Distribution: Normal (CPDATA1.STA)

Specifications: Lower=245.000 Nominal=250.000 Upper=255.000

Mean:248.66,Std.Dv:.98875

Observed Percent

Observed

Expected Percent

Expected

Above USL:

Below LSL:

Total

0 0.00 0.000000 0.000000

0 0.00 0.010917 0.010917

0 0.00 0.010917 0.010917
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Example 3

Calculate the capability indices and the proportion beyond 

specs (above USL or below LSL) for YS3 data in the dataset 

cpdata1.mtw!

The specification is 2505 unit.

Minitab>Stat>Quality Tools>Capability Analysis>Normal

Options: 

Perform Analysis: Overall analysis

Target
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255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

Process Data

Sample N 100

StDev (O v erall) 0.991247

LSL 245

Target 250

USL 255

Sample Mean 248.655

O v erall C apability

C pm 1.00

Pp 1.68

PPL 1.23

PPU 2.13

Ppk 1.23

O bserv ed Performance

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

Exp. O v erall Performance

PPM < LSL 113.24

PPM > USL 0.00

PPM Total 113.24

Process Capability of YS2
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i xx
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Pp→Cp

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

LSL 245

Target 250

USL 255

Sample Mean 250.727

Sample N 100

StDev (O v erall) 1.28587

Process Data

Pp 1.30

PPL 1.48

PPU 1.11

Ppk 1.11

C pm 1.13

O v erall C apability

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

O bserv ed Performance

PPM < LSL 4.23

PPM > USL 444.57

PPM Total 448.79

Exp. O v erall Performance

Process Capability of YS3
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Example 3

Calculate the capability indices and the proportion beyond 

specs (above USL or below LSL) for YS3 data in the dataset 

cpdata1.sta

Open cpdata1.sta Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Variables: YS3

Process specs…
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Variable: YS3        Mean: 250.727    Sigma: 1.28587

Specifications: LSL=245.000 Nominal=250.000 USL=255.000

Normal: Cp=1.296 Cpk=1.108 Cpl=1.484 Cpu=1.108

245 246 247 248 249 250 251 252 253 254 255
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Variable: YS3, Distribution: Normal (CPDATA1.STA)

Specifications: Lower=245.000 Nominal=250.000 Upper=255.000

Mean:250.73,Std.Dv:1.2859

Observed Percent

Observed

Expected Percent

Expected

Above USL:

Below LSL:

Total

0 0.00 0.044457 0.044457

0 0.00 0.000423 0.000423

0 0.00 0.044880 0.044880

Advanced, normal tab

Descriptive statistics Number beyond specs

Descriptive Statistics (cpdata1)

Variable:YS3

N = 100

Statistic Value

Mean

Median

25th Percentile (Q25)

75th Percentile (Q75)

Minimum Value

Maximum Value

Standard Deviation

Variance

Skewness

Kurtosis

Number of samples

Sample size

Sigma-S (R-bar/d2)

250.72650101

250.64471611

249.98634861

251.66952729

247.01558714

253.67427420

1.28586569

1.65345058

-0.33163172

-0.10175535

20.00000000

5.00000000

1.11677233
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Example 13

Compare two processes, the specification for both is 100±1. 

I.   =0.2, =99.5, that is the center of fluctuation deviates 

from the nominal value

II.  =0.4,  =100, that is the center of fluctuation is the 

nominal value, but the fluctuation is larger
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MSE for the two processes:

Capability indices for the two processes:

CP=

CPU=

CPL=

CPK=

CPm=
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Example 14

The specification is 100±1, the estimate of  is s=0.2. 

Calculate the capability indices and the proportion beyond 

specs (above USL or below LSL), if the estimate of  is 100, 

99.5 and 100.5!
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 CP CPU CPL CPK

 100.0

   99.5

 100.5

 


−
=

USL
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 >USL 


−
=

LSL
zalsó

 <LSL 

 100.0     

   99.5     

 100.5     
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26. példa

Egy gyártási folyamatban ellenőrző kártya felvételekor kapott 

adatok a cpdata1.mtw file YS3 oszlopában vannak. Az előírás 

2505 egység.

Számítsuk ki a folyamatképességi indexeket! A termék 

mekkora része lesz kívül a tűrési tartományon (lesz USL

fölött ill. LSL alatt)?

Minitab>Stat>Quality Tools>Capability Analysis>Normal

Options: 

Perform Analysis: Overall analysis

Target
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Pp→Cp

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

LSL 245

Target 250

USL 255

Sample Mean 250.727

Sample N 100

StDev (O v erall) 1.28587

Process Data

Pp 1.30

PPL 1.48

PPU 1.11

Ppk 1.11

C pm 1.13

O v erall C apability

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

O bserv ed Performance

PPM < LSL 4.23

PPM > USL 444.57

PPM Total 448.79

Exp. O v erall Performance

Process Capability of YS3

( )
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Case of one-sided specification

Example 6
A. R. Tenner, I. J. DeToro: Total Quality Management, Addison-Wesley, 1992

Capability analysis for sick leave security payments

Specification: pay out within 14 days

Sicksec.sta

6

LSLUSL
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−
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Variable: days   Mean: 10.0852

Sigma (Total):2.94740 Sigma (Within):0.00000

Specif ications: Nominal= ----   USL=14.0000

Normal: Cpk=.4427 Cpu=.4427

 Total

 Within
-5 0 5 10 15 20 25 30

-3.s(T) USL +3.s(T)
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Case of one-sided specification

Example 24
A. R. Tenner, I. J. DeToro: Total Quality Management, Addison-Wesley, 1992

Capability analysis for sick leave security payments

Specification: pay out within 14 days

Sicksec.mtw
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
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Minitab>Stat>Quality Tools>Capability 

Analysis>Normal

Options: Perform Analysis: Overall analysis

211815129630

USL

LSL *

Target *

USL 14

Sample Mean 10.0852

Sample N 3870

StDev (O v erall) 2.9474

Process Data

Pp *

PPL *

PPU 0.44

Ppk 0.44

C pm *

O v erall C apability

PPM < LSL *

PPM > USL 87080.10

PPM Total 87080.10

O bserv ed Performance

PPM < LSL *

PPM > USL 92054.89

PPM Total 92054.89

Exp. O v erall Performance

Process Capability of days
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ObservedExpected

enumerativeinferential
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Process capability and process 
performance (short term and long 

term)

ST

P

LSLUSL
C

6

−
=

LT

P

LSLUSL
P

6

−
=

6

LSLUSL
CP

−
=

which  ?

ST

(short term)

LT

(long term)

ST

P

LSLUSL
C

6

−
=
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Estimating variance from the within-samples (short term)

changes refers the internal, random fluctuation → CP

(potential capability)

Combining both within-samples and between-samples

changes the long term fluctuation is considered → PP (process

performance)

PP CP 
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Open Data Table

Chartdata1.xls

Analyze>Distribution

Y, Column: Y3

Capability Analysis
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Example 6

Calculate the performance indices for YS3 data in the dataset 

cpdata1.sta

Statistics>Industrial Statistics>Process Analysis

Process capability analysis



124Six Process Capability

Variable: YS3        Mean: 250.727

Sigma (Total):1.28587 Sigma (Within):1.04962

Specif ications: LSL=245.000 Nominal=250.000 USL=255.000

Normal: Cp=1.588 Cpk=1.357 Cpl=1.819 Cpu=1.357

 Total

 Within
245 246 247 248 249 250 251 252 253 254 255

LSL -3.s(T) NOMINAL +3.s(T)
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Process Capability Z-bench Statistics, Confidence Bounds etc (CPDATA1.STA)

Variable: YS3

Capability Index Value

Cp - Lower CI

Cp - Upper CI

Cpk - Lower CI

Cpk - Upper CI

Z - benchmark Potential

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Overall Process Performance

PPM < LSL

PPM > USL

PPM Total

Observed Process Performance

PPM < LSL

PPM > USL

PPM Total

Cpm - Lower CI

Cpm - Upper CI

1.34213

1.83320

1.13696

1.57737

4.07125

5.45581

4.07149

1.79578

0.02438

23.35658

23.38095

0.00000

0.00000

0.00000

0.97565

1.27832

Variable: YS3 (CPDATA1.STA)

-3.000 *Sigma=247.578

+3.000 *Sigma=253.875

Capability Index Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

CP  (potential capability)

CR  (capability ratio)

CPK (demonstrated excellence)

CPL (lower capability index)

CPU (upper capability index)

K   (non-centering correction)

CPM (potential capability II)

245.0000

250.0000

255.0000

1.5879

0.6298

1.3572

1.8186

1.3572

0.1453

1.1271

Summary: Current variable
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Process Capability Z-bench Statistics, Confidence Bounds etc (CPDATA1.STA)

Variable: YS3

Value

Pp - Lower CI

Pp - Upper CI

Ppk - Lower CI

Ppk - Upper CI

Z - benchmark Overall

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Potential Process Performance

PPM < LSL

PPM > USL

PPM Total

1.115754E+00

1.476234E+00

9.402471E-01

1.275380E+00

3.320802E+00

4.453421E+00

3.323441E+00

1.785034E+00

-3.000000E+30

4.225645E+00

4.445709E+02

4.487965E+02

Variable: YS3 (CPDATA1.STA)

-3.000 *Sigma=246.869

+3.000 *Sigma=254.584

Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

PP  (performance index)

PR  (performance ratio)

PPK (perf. demonstr. excell.)

PPL (lower performance index)

PPU (upper performance index)

245.0000

250.0000

255.0000

1.2961

0.7715

1.1078

1.4845

1.1078
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5. példa

Example 6

Calculate the capability and performance indices together 

with the expected proportion of non-conforming items for 

YS3 data in the dataset cpdata1.mtw!

The specification is 2505 unit.

Minitab>Stat>Quality Tools>Capability Analysis (Normal)>Options: 

Perform Analysis: Within subgroup analysis, Overall analysis

Target
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6

LSLUSL
CP

−
=
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withinbetween  ++ 5.250= ( )1,0~between N ( )1,0~within N

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

LSL 245

Target 250

USL 255

Sample Mean 250.727

Sample N 100

StDev (Within) 1.0529

StDev (O v erall) 1.28587

Process Data

C p 1.58

C PL 1.81

C PU 1.35

C pk 1.35

Pp 1.30

PPL 1.48

PPU 1.11

Ppk 1.11

C pm 1.13

O v erall C apability

Potential (Within) C apability

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

O bserv ed Performance

PPM < LSL 0.03

PPM > USL 24.66

PPM Total 24.69

Exp. Within Performance

PPM < LSL 4.23

PPM > USL 444.57

PPM Total 448.79

Exp. O v erall Performance

Within

Overall

Process Capability of YS3
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The indices computed from sample data are random variables, give 

their confidence interval as well!

only sampling 

uncertainty is 

considered, 

meaurement 

uncertainty is 

disregarded
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Open cpdata1.sta Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Variables: YS3, by MINTAS

Process specs…, Summary histogram
Variable: YS3        Mean: 250.727

Sigma (Total):1.28587 Sigma (Within):1.11677

Specifications: LSL=245.000 Nominal=250.000 USL=255.000

Normal: Cp=1.492 Cpk=1.276 Cpl=1.709 Cpu=1.276

 Total

 Within244 245 246 247 248 249 250 251 252 253 254 255 256

LSL -3.s(T) NOMINAL +3.s(T) USL

0

5

10

15

20

25

30

35

F
re

q
u

e
n

c
y



133Six Process Capability

Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Summary: Current variable

YS3; Set 0 (Default Set) (cpdata1)

-3.000 *Sigma= 246.86890

3.000 *Sigma= 254.58410

Performance Index Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

PP  (performance index)        

PR  (performance ratio)        

PPK (perf. demonstr. excell.)  

PPL (lower performance index)  

PPU (upper performance index)  

245.0000

250.0000

255.0000

1.2961

0.7715

1.1078

1.4845

1.1078

YS3; Set 0 (Default Set) (cpdata1)

-3.000 *Sigma= 247.37618

3.000 *Sigma= 254.07682Capability Index

Within-sample sigma=R-bar/d2 Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

CP  (potential capability)     

CR  (capability ratio)         

CPK (demonstrated excellence)  

CPL (lower capability index)   

CPU (upper capability index)   

K   (non-centering correction) 

245.0000

250.0000

255.0000

1.4924

0.6701

1.2756

1.7092

1.2756

0.1453
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Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Variables: YS3, by MINTAS

Process specs…, Advanced, normal fül

Descriptive statistics Number beyond specs

Descriptive Statistics (cpdata1)

Variable:YS3

N = 100

Statistic Value

Mean

Median

25th Percentile (Q25)

75th Percentile (Q75)

Minimum Value

Maximum Value

Standard Deviation

Variance

Skewness

Kurtosis

Number of samples

Sample size

Sigma-S (R-bar/d2)

250.72650101

250.64471611

249.98634861

251.66952729

247.01558714

253.67427420

1.28586569

1.65345058

-0.33163172

-0.10175535

20.00000000

5.00000000

1.11677233

Variable: YS3, Distribution: Normal (cpdata1)

Specifications: Lower=245.000 Nominal=250.000 Upper=255.000

Mean:250.73,Std.Dv:1.2859

Observed Percent

Observed

Expected Percent

Expected

Above USL:

Below LSL:

Total

0 0.00 0.044457 0.044457

0 0.00 0.000423 0.000423

0 0.00 0.044880 0.044880
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Open cpdata1.sta Statistics>Industrial Statistics>Process Analysis

Process capability analysis

Variables: YS3, by MINTAS

Process specs…, Advanced, normal fül

Summary: Current variable, Descriptive statistics, 

Summary histogram
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withinbetween  ++ 5.250= ( )1,0~between N ( )1,0~within N

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

Process Data

Sample N 100

StDev (Within) 1.05290

StDev (O v erall) 1.28912

LSL 245.00000

Target 250.00000

USL 255.00000

Sample Mean 250.72650

Potential (Within) C apability

C PU 1.35

C pk 1.35

Lower C L 1.13

Upper C L 1.57

C C pk 1.58

C p

O v erall C apability

Pp 1.29

Lower C L 1.11

Upper C L 1.47

PPL 1.48

PPU

1.58

1.11

Ppk 1.11

Lower C L 0.94

Upper C L 1.27

C pm 1.13

Lower C L

Lower C L

0.98

1.34

Upper C L 1.83

C PL 1.81

O bserv ed Performance

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

Exp. Within Performance

PPM < LSL 0.03

PPM > USL 24.66

PPM Total 24.69

Exp. O v erall Performance

PPM < LSL 4.45

PPM > USL 458.11

PPM Total 462.57

Within

Overall

Process Capability of YS3
(using 95.0% confidence)
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The indices computed from sample data are random variables, give 

their confidence interval as well!

only sampling 

uncertainty is 

considered, 

meaurement 

uncertainty is 

disregarded

Advanced, normal tab Summary: Current variable

Process Capability (CPDATA1.STA)

Variable: YS3

Capability Index Value

Cp - Lower CI

Cp - Upper CI

Cpk - Lower CI

Cpk - Upper CI

Z - benchmark Potential

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Overall Process Performance

PPM < LSL

PPM > USL

PPM Total

Observed Process Performance

PPM < LSL

PPM > USL

PPM Total

Cpm - Lower CI

Cpm - Upper CI

1.24897

1.73537

1.05721

1.49389

3.82610

5.12772

3.82665

1.79471

0.14663

64.94899

65.09563

0.97565

1.27832

Process Capability

Variable: YS3

Value

Pp - Lower CI

Pp - Upper CI

Ppk - Lower CI

Ppk - Upper CI

Z - benchmark Overall

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Potential Process Performance

PPM < LSL

PPM > USL

PPM Total

1.1158

1.4762

0.9402

1.2754

3.3208

4.4534

3.3234

1.7850

4.2256

444.5709

448.7965
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withinbetween  ++ 5.250= ( )1,0~between N ( )1,0~within N

within between overall
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Between/Within

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

Process Data

Sample N 100

StDev (Between) 0.344972

StDev (Within) 0.985079

StDev (B/W) 1.04374

StDev (O v erall) 1.34392

LSL 245

Target 250

USL 255

Sample Mean 250.705

B/W C apability

C C pk 1.60

O v erall C apability

Pp 1.24

PPL 1.42

PPU 1.07

Ppk

C p

1.07

C pm 1.10

1.60

C PL 1.82

C PU 1.37

C pk 1.37

O bserv ed Performance

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

Exp. B/W Performance

PPM < LSL 0.02

PPM > USL 19.37

PPM Total 19.40

Exp. O v erall Performance

PPM < LSL 10.92

PPM > USL 697.38

PPM Total 708.30

B/W

Overall

Between/Within Capability of YS4

( )

99

100
2

Overall

 −

= i

i xx

s
2

W

2

BB/W sss +=

overall and

B/W are not 

identical

How to estimate?
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Machine and process capability

8

LSLUSL
CM

−
=

6

LSLUSL
CP

−
=

The process contains several sub-processes/machines.

To maintain acceptable CP (e.g. 1.67), the sub-processes should 

be better.



142Six Process Capability

A toaster consists of 20 parts. If the proportion of 

nonconforming is 63.4ppm for each, how much is the CP for a 

well centered process? 

66

LSLUSL
P

zzLSLUSL
C

−
=

−
=

 

−
=

x
z

How much is the proportion of nonconforming for the 

toaster?

How much is Cp in case of well centered process, based on 

the proportion of nonconforming?
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Non-normal distributions

The process capability characterizes the proportion of non-

conforming items.

If CP =1 and the process is centered, the proportion of non-

conforming is 0.0027.

USLLSL

UNTLLNTL

CP=1



T

+3-3

0.00135
0.00135
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Variable: JKIVTERF   Mean: 2.13065    Sigma: .027933

Specifications: LSL=2.00000 Nominal=2.10000 USL=2.20000

Normal: Cp=1.193 Cpk=.8276 Cpl=1.559 Cpu=.8276

1.98 2.00 2.02 2.04 2.06 2.08 2.10 2.12 2.14 2.16 2.18 2.20 2.22

LSL -3.s NOMINAL USL

0
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F
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q
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e
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y

Example 12
Ampoule filling process

USL=2.2

LSL=2.0
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Example 12

Ampoule filling process

tolt.mtw

2.202.162.122.082.042.00

LSL USL

LSL 2

Target *

USL 2.2

Sample Mean 2.13065

Sample N 48

StDev (O v erall) 0.0279331

Process Data

Pp 1.19

PPL 1.56

PPU 0.83

Ppk 0.83

C pm *

O v erall C apability

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

O bserv ed Performance

PPM < LSL 1.45

PPM > USL 6519.72

PPM Total 6521.17

Exp. O v erall Performance

Process Capability of JKIVTERF

Stat>Capability Analysis (Normal)

USL=2.2

LSL=2.0
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U
0.00135

(2)

L
0.00135

(2)

L
0.00135

(N)

U
0.00135

(N)

N


2
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pp

P
LU

LSLUSL
C

−

−
=

e the median, 

Up the critical value 

for P=0.99865, 

Lp the critical value 

for P= 0.00135

ep

e

PU
U

USL
C





−

−
=

pe

e

PL
L

LSL
C

−

−
=




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ampoule filling process

Variable: JKIVTERF   Mean: 2.13065    Sigma: .027933

Non-Normal Fit; Skewness: -.18947        Kurtosis: -1.1105

Specifications: LSL=2.00000 Nominal= ----   USL=2.20000

(NOTE: Sigma limits are indicated at equivalent percentile values)

Normal: Cp=1.193 Cpk=.8276 Cpl=1.559 Cpu=.8276 Non-Normal: Cp=1.944 Cpk=1.514

1.98 2.00 2.02 2.04 2.06 2.08 2.10 2.12 2.14 2.16 2.18 2.20 2.22

LSL -3.s +3.s USL
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The meaning of 6 sigma

In a 6 sigma process the proportion of defects  is 3.4 

ppm, 

DPMO: Defect Per Million Opportunities



150Six Process Capability

The capability analysis is meaningful only for a stable (in control) 

process.

The two phases:

1. Stabilize the process for a reasonable time, removing the potential 
sources of variation (e.g. operator, batch of raw material) 

2. Compare th long-term process capability with that expected

How to check the stability of the process?
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The sigma capability measures the distance between the 

nominal value and the specification limit, in  units.

USLLSL
3 3

== PKP CC

6

LSLUSL
CP

−
=

3=Z

3

TUSL
CC PKP

−
==If the process is centred:

p=

ppm
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USLLSL
6 6

== PKP CC

6=Z

p= ppm

… if the process were centred (=T), but …

Motorola: 1.5 shift
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2=PC CPK = 15. Z=6 ( process with 6 sigma capability)

USLLSL 6 6T

1.5

3.4 ppm



0 ppm
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The sigma capability is a special scale for proportion 

of defects

 

sigma  

capability (Z) 

CP CPK with 1.5 

  shift 

DPMO 

2 0.67 0.17 308537 

3 1 0.5 66807 

4 1.33 0.67 6210 

5 1.67 1.17 233 

6 2 1.5 3.4 
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Z

pp
m

1
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1e3

1e4

1e5

1e6

1 2 3 4 5 6
Z= 1.5+3*Cpk
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If the shift differs from 1.5, 

ZLT+1.5  ZST

(LT: long term) (ST: short term)
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u

/2 /2

0

Z

generalisation

do not care with the 

extent of shift

any distribution

5.1+= zZ
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Short term   capability, alternative definitions

st

st

TSL
Z



−
=

where SL is USL or LSL

Minitab Six Sigma Process Report

This would be the short term  capability of the process if it 

were properly centred

st

st

SL
Z



−
= Minitab Capability Analysis

Statistica Process Analysis
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Process Capability Z-bench Statistics, Confidence Bounds etc (CPDATA1.STA)

Variable: YS3

Capability Index Value

Cp - Lower CI

Cp - Upper CI

Cpk - Lower CI

Cpk - Upper CI

Z - benchmark Potential

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Overall Process Performance

PPM < LSL

PPM > USL

PPM Total

Observed Process Performance

PPM < LSL

PPM > USL

PPM Total

Cpm - Lower CI

Cpm - Upper CI

1.34213

1.83320

1.13696

1.57737

4.07125

5.45581

4.07149

1.79578

0.02438

23.35658

23.38095

0.00000

0.00000

0.00000

0.97565

1.27832

Variable: YS3 (CPDATA1.STA)

-3.000 *Sigma=247.578

+3.000 *Sigma=253.875

Capability Index Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

CP  (potential capability)

CR  (capability ratio)

CPK (demonstrated excellence)

CPL (lower capability index)

CPU (upper capability index)

K   (non-centering correction)

CPM (potential capability II)

245.0000

250.0000

255.0000

1.5879

0.6298

1.3572

1.8186

1.3572

0.1453

1.1271

Example 9

Compute the sigma capability of data in YS3 column of cpdata1.sta

file! Specification: 2505 unit.
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st

st

SL
Z



−
=

(Statistica Process Analysis)

short term

071.4
0496.1

7265.250255
=

−
=USLZ

456.5
0496.1

2457265.250
=

−
=LSLZ

( ) ppm5.23= USLZzP

( ) ppm024.0= LSLZzP

ppm52.23=totalP 071.4=stZ
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ST

(short term)

LT

(long term)

Long term   capability

lt

lt

SL
Z



−
=
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Process Capability Z-bench Statistics, Confidence Bounds etc (CPDATA1.STA)

Variable: YS3

Value

Pp - Lower CI

Pp - Upper CI

Ppk - Lower CI

Ppk - Upper CI

Z - benchmark Overall

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Potential Process Performance

PPM < LSL

PPM > USL

PPM Total

1.115754E+00

1.476234E+00

9.402471E-01

1.275380E+00

3.320802E+00

4.453421E+00

3.323441E+00

1.785034E+00

-3.000000E+30

4.225645E+00

4.445709E+02

4.487965E+02

Variable: YS3 (CPDATA1.STA)

-3.000 *Sigma=246.869

+3.000 *Sigma=254.584

Value

Lower Specification Limit

Nominal Specification

Upper Specification Limit

PP  (performance index)

PR  (performance ratio)

PPK (perf. demonstr. excell.)

PPL (lower performance index)

PPU (upper performance index)

245.0000

250.0000

255.0000

1.2961

0.7715

1.1078

1.4845

1.1078



163Six Process Capability

(Statistica Process Analysis)

long term

lt

lt

SL
Z



−
=

323.3
286.1

7265.250255
=

−
=USLZ

452.4
286.1

2457265.250
=

−
=LSLZ

( ) ppm445= USLZzP

( ) ppm3.4= LSLZzP

ppm449=totalP 32.3=ltZ

07.4=stZ 75.032.307.4 =−=shiftZ
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Variable: YS3, Distribution: Normal (cpdata1)

Specifications: Lower=245.000 Nominal=250.000 Upper=255.000

Mean:250.73,Std.Dv:1.2859

Observed Percent

Observed

Expected Percent

Expected

Above USL:

Below LSL:

Total

0 0.00 0.044457 0.044457

0 0.00 0.000423 0.000423

0 0.00 0.044880 0.044880

Process Capability Z-bench Statistics, Confidence Bounds etc (cpdata1)

Value

Pp - Lower CI

Pp - Upper CI

Ppk - Lower CI

Ppk - Upper CI

Z - benchmark Overall

Z benchmark - LSL

Z benchmark - USL

Z benchmark - Lower CI

Z benchmark - Upper CI

Potential Process Performance

PPM < LSL

PPM > USL

PPM Total

1.115754E+00

1.476234E+00

9.402471E-01

1.275380E+00

3.320802E+00

4.453421E+00

3.323441E+00

1.785034E+00

-3.000000E+30

4.225645E+00

4.445709E+02

4.487965E+02

3.32+1.5=4.82



165Six Process Capability

with the alternative short term sigma capability definition:

st

st

TSL
Z



−
=

76.4
0496.1

250255
=

−
=stZ

44.132.376.4 =−=shiftZ32.3=ltZ
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Example 15

Compute the sigma capability of data in YS3 column of 

cpdata1.mtw file! 

Specification: 2505 unit.
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Options: benchmark Z’s Szigma képesség: 3.32+1.5=4.82

255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

Process Data

Sample N 100

StDev (Within) 1.11674

StDev (O v erall) 1.28912

LSL 245

Target 250

USL 255

Sample Mean 250.727

Potential (Within) C apability

C C pk 1.49

O v erall C apability

Z.Bench 3.31

Z.LSL 4.44

Z.USL 3.32

Ppk

Z.Bench

1.11

C pm 1.13

3.83

Z.LSL 5.13

Z.USL 3.83

C pk 1.28

O bserv ed Performance

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

Exp. Within Performance

PPM < LSL 0.15

PPM > USL 64.92

PPM Total 65.06

Exp. O v erall Performance

PPM < LSL 4.45

PPM > USL 458.11

PPM Total 462.57

Within

Overall

Process Capability of YS3



168Six Process Capability

The Z value (as CP, CPK) computed from sample data are 

random variables, give their confidence interval as well.!
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255.0253.5252.0250.5249.0247.5246.0

LSL Target USL

Process Data

Sample N 100

StDev (Within) 1.05290

StDev (O v erall) 1.28912

LSL 245.00000

Target 250.00000

USL 255.00000

Sample Mean 250.72650

Potential (Within) C apability

Z.USL 4.06

C pk 1.35

Lower C L 1.13

Upper C L 1.57

C C pk 1.58

Z.Bench

O v erall C apability

Z.Bench 3.31

Lower C L 1.78

Upper C L *

Z.LSL 4.44

Z.USL

4.06

3.32

Ppk 1.11

Lower C L 0.94

Upper C L 1.27

C pm 1.13

Lower C L

Lower C L

0.98

1.80

Upper C L *

Z.LSL 5.44

O bserv ed Performance

PPM < LSL 0.00

PPM > USL 0.00

PPM Total 0.00

Exp. Within Performance

PPM < LSL 0.03

PPM > USL 24.66

PPM Total 24.69

Exp. O v erall Performance

PPM < LSL 4.45

PPM > USL 458.11

PPM Total 462.57

Within

Overall

Process Capability of YS3
(using 95.0% confidence)

MTB14
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Calculation of sigma capability: 

DPMO→zLT→Z=z+1.5

Special case STT  5.1+= LTST  =

5.1
5.1

+=
+−

=
−

= z
USLTUSL

Z
ST

ST

ST 



 shiftZ

General case zZ
TUSLTUSL

Z
STSTST

shift −=
−

=
−

−
−

=










zZ
USLTUSL

Z
LTST

shift −=
−

−
−

=






lt

lt

SL
Z



−
=
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The process capability study is to be interpreted for in-control 

processes only.

Two parts of the task:

1. Stabilize the process for an acceptable time span, eliminating 
potential sources of fluctuation (e.g. operator, lot of raw material)

2. Compare the long term process performance with that expected

How to check stability?


